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A.  General Information 
 
These exercises are designed to accomplish three objectives: (1) provide 
students with rudimentary knowledge of technological tools (hardware and 
software); (2) complement and support the study of music theory (harmony, 
voice-leading, form, etc); and (3) encourage creative and engaged learning 
through the activities of improvisation and composition. 
 
After completing these exercises, students will have a working knowledge of 
the following aspects of music technology: MIDI sequencing, audio 
recording, working with loops, computer-based music notation, exporting 
content in mp3 and pdf file formats, secure online transfer of data, and 
maintaining backups of data.  Most students will choose to complete the 
exercises in Furman's music technology lab, which contains Macintosh 
computers.  However, the assignments are designed to accommodate a 
variety of choices of hardware and software. 
 
For each of the four terms in the core theory sequence, students will 
complete two exercises: a midterm assignment emphasizing improvisation, 
and a final project emphasizing composition. For each exercise, students will 
be provided an Instruction Sheet with specific guidelines for that particular 
exercise (key, tempo, chord progression, length, form, instrumentation, 
etc). 
 
The Furman Advantage program has provided a teaching assistant, who will 
be available during posted office hours to provide assistance to students 
working in the lab.   
Questions may also be directed to Dr. Daniel Koppelman, Director of Music 
Technology, at extension 2094 or via e-mail 
<daniel.koppelman@furman.edu>.  
 
Important: The directions provided below are designed for students 
working in the music technology lab at Furman.  It may be possible for some 
students to complete the exercises using different hardware and/or 
software.  However, regardless of how or where the exercises are 
undertaken the end result (what is turned in) must meet these 
specifications: 
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All assignments will be turned in using Furman’s “Box” (storage and 
collaboration) system.  You will receive an electronic “invitation” to join your 
theory class’s Box folder; after accepting the invitation, you will be able to 
deposit your assignments into the class Box folder.  Be aware, however, that 
once you deposit your assignment, you will not have permission to view, 
edit, or delete your files. 

 
To access your Box folder:  
 

1.  Type the address: my.Furman.edu into a browser: 

 
 

2.  Enter your network username and password, then click Sign In: 

 
 

3.  From the selection screen that appears, click on Box: 
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4.  Log into Box with your Furman Net ID and Password 
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You should now see one or more Box folders: 

 
 
 
Your theory class folder will have the course number of your current class, 
and your instructor’s name  
(in the example above, MUS-111-Koppelman) 
 
This is the folder into which you will deposit your Technology Assignments.  
See below for more details regarding the types of folders and/or files that 
you will deposit into your Box folder.  [Tech note: you will not be allowed to 
drag a folder from your computer into your Box folder.  Therefore, you will 
first create and name a folder from within Box; then you will drag files from 
your computer into this newly created Box folder.] 
 
Throughout the directions, when you are asked to create a file or folder 
containing “yourlastname,” replace this with your last name (for example, 
yourlastname_midterm would become Lindsey_midterm if your name 
was Mary Lindsey.  If there are multiple students in your class with the same 
last name, ask your instructor how to title your files and folders. 
 
When finished working, please make sure to sign out of Box, sign out of 
myFurman, and close your browser.  This is vital to ensure the privacy of 
your work! 
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B.  Basic Directions in Outline Form 
This section is for students who believe they can complete the assignments 
with little or no step-by-step instructions.  See section C below for step-by-
step instructions. 
 
Midterm Assignment 
1.  Using a given structure (as directed on a separate “Midterm Assignment 
Instructions” sheet), enter an accompaniment into GarageBand (GB) using 
the MIDI keyboard.  Save this GB file.  Create an mp3 file of this 
accompaniment.  Name the mp3 file yourlastname_accomp (the computer 
may display the file as yourlastname_accomp.mp3). 
2.  Practice improvising over this accompaniment: while listening to the 
accompaniment, perform an improvisation on a MIDI keyboard or with your 
live instrument/voice. 
3.  Make a recording in GarageBand of your best improvisation.  Your 
recording will be a combination of your prerecorded accompaniment plus 
your live improvisation on either a MIDI keyboard or your instrument/voice).   
4.  Save your improvisation recording as an mp3 file.  Name the file 
yourlastname_improv 
5.  Upload your files to Box.  Inside your theory class Box folder, create a 
folder called yourlastname_midterm (see section C below for step-by-step 
instructions if needed). 
Drag your two files (yourlastname_accomp and yourlastname_improv) 
from your computer into the yourlastname_midterm folder on Box. 
 

 
 
Final Project 
1. Following the guidelines (as directed on a separate “Final Project 
Instructions” sheet), compose a short piece. 
2. Create a computer-notated version of your composition.  Print a hard 
copy.  Using pencil, add harmonic analysis (key and Roman numerals) and 
embellishing tones (MUS-112 final project only).  Create and save another 
copy of your notation as a pdf file; name it yourlastname_composition. 
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3. Create and save an audio recording of your composition as an mp3 file; 
name it yourlastname_audio. 
4.  Write one page of analytical commentary about your composition.  Print 
a hard copy.  Save a copy of your analysis as a Microsoft Word file; name it 
yourlastname_analysis. 
5.  Upload your files to Box.  Inside your theory class Box folder, create a 
folder called yourlastname_final (see section C below for step-by-step 
instructions if needed). 
Drag your three files (yourlastname_composition, 
yourlastname_audio, and yourlastname_analysis) from your computer 
into the yourlastname_final folder on Box. 
6.  Turn in the hard copies of your composition and analysis to your 
instructor. 
 
 
C.  Step-by-Step Instructions 
 
Midterm Assignment step-by-step 
 
Before starting, create a new folder, inside the Music Students folder on 
your computer, where you will store all your files for this exercise.  This 
location will be referred to as your Assignment Folder.  
 

A note on naming files and folders.  It is suggested that you adopt 
a logical system for naming your files and folders.  For example, if 
your last name was Furman, your Personal folder might be named 
Furman, and you would then create sub-folders for each assignment 
or project.  Your Midterm Assignment folder might be named 
Furman_midterm; and your Final Project folder might be named 
Furman_final.  Then you could name your midterm files 
Furman_accomp.mp3, or Furman_improv.mp3, etc.  Having a logical 
system of names can really come in handy if you misplace a file or 
folder (which is easy to do in a shared lab with 100 or so users).  
Having your name be part of the filename is the best way to make 
sure you can find your file if it becomes misplaced. 

 
1.  Using the MIDI Keyboard, enter your accompaniment into GarageBand 
(GB). 

- Launch GB by clicking its icon in the dock:  
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- If someone else’s project opens, go to the File menu and select 
New… 
- Click on Empty Project, then click Choose. 
- Click on Software Instrument, then click Create. 
- When the empty project opens, close the Musical Typing window if 
necessary, then go to the File menu and select Save; give your 
project a name, and save it to your Assignment Folder. 
- Play a few notes on your MIDI keyboard to test connections (you 
should hear a piano sound). 
- From the list of instruments on the left-hand side of the screen, 
change the instrument if you wish.  Confirm the sound by playing on 
your MIDI keyboard. 
- Set the key, tempo, and time signature to your liking: 

 
- Consult your Instruction Sheet for the specific accompaniment to be 
recorded. 
- From the Record menu, set Count In to 1 Bar. 
- Make sure both the Count In and Metronome are on (click the “1234” 
button and the Metronome icon). 

 
- Click the Red record button, wait one measure (you should hear the 
Count In), then record your accompaniment; make sure you record 
the correct number of measures, as specified in your Midterm 
Assignment Instruction Sheet.  Click the Stop button when finished 
recording.  Delete any excess measures from the end of your track(s).  
Save your project.  Rewind to the beginning of the project and listen to 
your recording.  If satisfied with recording, go on to next step; if not, 
repeat recording until satisfied. 
- OPTIONAL: From the View menu, select Show Apple Loops. Select 
a drum or percussion loop, and drag the loop into your project.  
Extend the loop to match the length of your accompaniment.  Listen.  
Save. 
- Create an mp3 file of your saved accompaniment. From the Share 
menu, select Export Song to Disk…, name your file 
yourlastname_accomp, and make sure you are saving it to your 
Assignment Folder.  Select MP3 for the filetype, and select High 
Quality from the Quality pop-up menu.  Then click Export. 
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- Go to your Assignment Folder, and make sure your yourlastname 
_accomp file is there.  Double-click the file to hear it in iTunes, or 
simply select it and press the space bar to listen to it. 
 

2.  Practice improvising over the accompaniment. 
This can be done: 
- at the computer, listening to your accompaniment in iTunes while 
improvising along (on the MIDI keyboard, or using your instrument or 
voice),  
OR 
- in a practice room, listening to your mp3 file (in iTunes or another 
music program) while improvising along (on a piano, or using your 
instrument or voice). 
 

Be sure to consult your Midterm Assignment Instruction Sheet for 
guidelines concerning your improvisation (how many repetitions of your 
accompaniment, note choice, stylistic suggestions, etc.)   

 
 
3.  Make a recording of your best improvisation.  Your recording will be a 
combination of your prerecorded accompaniment plus your live 
improvisation. 

This can be done either: 
- Using the X5 MIDI keyboard to record your keyboard playing into GB,  
OR 
- Using your instrument or voice, by checking out the AudioTechnica 
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USB mic from the music library to record audio into GB. 

 
 

Feel free to ask the Tech TA for assistance with using the USB mic. 
 

To record using the MIDI keyboard: 
- Open the accompaniment project which you saved in Step 1.  Your 
filename will end in .band: 

 
- Add a new track on which to record your improvisation:   

- select New Track… from the Track menu, 
- click the picture of the keyboard under “Software Instrument,” 
- then click Create. 
- Feel free to choose a new instrument sound from the Library at the 
left of the screen. 

 
- Make sure your newly added track is selected in the Tracks column of 
your project, then rewind back to the start of your accompaniment, 
make sure Count In is turned on, make sure Cycle Region is turned off 
(ask the TechTA for assistance with this if necessary), then hit the 
Record button and improvise while listening to the accompaniment.  
Consult your Instruction Sheet for guidelines concerning your recording 
(how many repetitions, stylistic suggestions, etc.)   
 
- When finished recording, click the Stop button. Rewind to the 
beginning and listen to your improvisation.  You should hear a 
combination of your prerecorded accompaniment plus your live 
improvisation.  If not satisfied, go to the Edit menu, choose Undo 
Recording and try it again.  Delete any extra measures from the end of 
your track(s). 
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- When satisfied, Save your project.  
 

To record using the USB microphone: 
 

- Check out the AudioTechnica USB microphone box from the library 
checkout desk 
- Set up the mic, following these instructions: 

 
 
- Plug the mic into the USB port on the back of the computer; also plug a 
pair of headphones into the back of the computer: 

 
 
- Open the accompaniment project which you saved in Step 1.  Your 
filename will end in .band: 

 
 
If the box pictured below pops up, click “Use.” 
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- Set up GB to use the mic 

- From the GarageBand menu, choose Preferences…, then click 
Audio/MIDI 
- In the Preferences window that opens, choose the following settings: 

Output device: Built-in Output 
Input device:   AT2020USB 
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- Close the Preferences window by clicking the red button in the upper 
left-hand corner of the window.  

 
- Add a new track on which to record your improvisation:   
 
- select New Track… from the Track menu, then click the picture of the 
microphone under “Audio”: 

 
 
- Using the pull-down menu below the word “Details,” set the Input to 
“Input 1” 
- click the box next to I want to hear my instrument as I play and 
record 
- make sure you see “My instrument is connected with 
AT2020USB” and “I hear sound from Built-in Output” as in the 
picture above, then click Create 
 

- You will see a new, blank Audio track. 
- play or sing directly into the microphone, and adjust the input level 
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slider if necessary (the input level slider is just to the left of the L/R 
knob): 

 
 
- Now hit the Record button and improvise while listening to the 
accompaniment.  Consult your Instruction Sheet for guidelines 
concerning your recording (how many repetitions, note choice, stylistic 
suggestions, etc.)   
 
- When finished recording, click the Stop button. Rewind to the 
beginning and listen to your improvisation.  You should hear a 
combination of your prerecorded accompaniment plus your live 
improvisation.  If not satisfied, go to the Edit menu, choose Undo 
Recording and try it again. 
 
- When satisfied, Save your project.  
 
Pack up the microphone box, making sure to put the USB cable, tripod, 
and pivot mount into the zippered pouch, and include the mic and 
instructions too.  Return the box to the library checkout desk. 
 

4.  Save your improvisation recording as an mp3 file as follows: 
- From the Share menu, select Export Song to Disk…, name your 
file yourlastname_improv, and make sure you are saving it to your 
Assignment Folder.  Select MP3 for the filetype, select High Quality 
from the Quality pop-up menu, and check the box next to “Export 
cycle area…”  Then click Export. 
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- Go to your Assignment Folder, and make sure your 
yourlastname_improv file is there.  Double-click the file to hear it in 
iTunes, or simply select it and press the space bar to listen to it.  Your 
recording will be a combination of your prerecorded accompaniment 
plus your live improvisation. 
 
- Be sure to save backup copies of your GB project and your two mp3 
files to a safe location (a flash drive or other external storage 
location). 
 

 
5.  Upload your files to Box. 
 

- Sign in to Box, following the directions above in section A.  
- Click on the Box folder with your theory class and instructor’s name. 

Midterm projects will go to your Aural instructor (MUS-111B or 
112B) 
Final projects will go to your Written instructor (MUS-111A or 
112A) 

- Create a yourlastname_midterm folder within your theory class 
folder: 

Click on New, then click Folder from the pop-up menu: 
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Name your folder yourlastname_midterm, then click Create. 
 

 

 
 
 



 16 

 
 
- Open your Assignment Folder on your computer desktop, and arrange 
it so that you can see your newly created Box folder and your 
Assignment Folder at the same time: 
 

 
 

- Drag your two mp3 files (yourlastname_accomp and 
yourlastname.improv) into your Box folder: 
 

 
 
- Congratulations!  You have finished the Midterm Assignment. 
 
 

Final Project step-by-step 
 
 
Before starting, create a new folder, inside the Music Students folder on 
your computer, where you will store all your files for this exercise.  This 
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location will be referred to as your Project Folder.  
 
1. Following steps 1 and 2 on the Final Project Instruction sheet, compose a 
short piece.  You may wish to jot this down in pencil on paper. 
 
2. Create a computer-notated version of your composition. 

Using Finale, create a file which follows the guidelines in your 
Instruction Sheet (score layout, number of staves, etc).  Be sure to 
include measure numbers.  Please delete any extraneous empty 
measures.  Print a hard copy.  Using pencil, add harmonic analysis 
(key and Roman numerals) and embellishing tones (MUS-112 final 
project only).  Save one copy of your notation file to disk; save 
another copy as a pdf file, as follows: 

- From within Finale, with your score as the front-most window, 
choose Print… from the File menu; when the pop-up menu 
appears, choose “Score only;” then press OK.  From the Print 
pop-up window, click the PDF button in the lower left-hand 
corner; then choose Save as PDF… from the pull-down menu.   
Name your file yourlastname_composition, and save it to 
your Project Folder. 
 

- To double-check your work, find your newly created pdf file, then 
double-click to open and view it using Preview.  Make sure it looks 
correct. 

 
3. Create an mp3 file of your composition.  This process consists of two 

steps: (1) use Finale to save an AIFF file of your composition; (2) use 
GarageBand to convert the AIFF file into an mp3 file. 

 
- Open the Finale file of your composition. 
- From the File menu, choose Export, then select Audio File… from 
the pop-up menu: 
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Choose AIFF File from the Format: pop-up menu, name your file 
yourlastname_aiff, and Save it into your Project Folder.  Your newly 
created AIFF file should appear in your Project Folder (it should have 
.aiff at the end of its name). 
 
- Open your Project Folder 
- Launch GarageBand by clicking its icon in the dock; from the File 
menu, select New…  Click on Empty Project, then click Choose.  
Click on the picture of the microphone under the Audio heading, then 
click Create.  A new, blank GB project with one audio track will open. 
 
- Move the GarageBand window so you can see your Project Folder 
window.  Drag your AIFF file onto the GarageBand window, “dropping” 
it in the blank space just to the right of the track name.  GarageBand 
will place the imported data beginning at measure 1 of the track.  (If 
for some reason your data starts later in the track, simply drag it to 
the left, so that it starts at measure 1.)   
- Export this one-track GB project as an mp3 file: 
From the Share menu, select Export Song to Disk…, name your file 
yourlastname_audio, and make sure you are saving it to your 
Project Folder.  Select MP3 for the filetype, select High Quality from 
the Quality pop-up menu, and check the box next to “Export cycle 
area…”  Then click Export. 
 
- Go to your Project Folder, and make sure your 
yourlastname_audio file is there.  Double-click the file to hear it in 
iTunes, or simply select it and press the space bar to listen to it. 
 

4.  Write one page of analytical commentary about your composition.   
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Following the guidlines in your Final Project Instruction Sheet, write 
one page of analytical commentary about your composition.  Be sure 
to refer to specific measure/beat locations in your composition.  Print a 
hard copy.  Save your commentary, as a Microsoft Word file, to your 
Project Folder; name this file yourlastname_analysis.   
 
- Be sure to save backup copies of your Finale project, your pdf copy, 
your mp3 file, and your analysis to a safe location (a flash drive or 
other external storage location). 

 
5.  Upload your files to Box. 
 

- Sign in to Box, following the directions above in section A.  
- Click on the Box folder with your theory class and instructor’s name. 

Midterm projects will go to your Aural instructor (MUS-111B or 
112B) 
Final projects will go to your Written instructor (MUS-111A or 
112A) 

- Create a yourlastname_final folder within your theory class folder: 
Click on New, then click Folder from the pop-up menu 

 
 
Name your folder yourlastname_final, then click Create. 
 

- Open your Project Folder on your computer desktop, and arrange it 
so that you can see your newly created Box folder and your Project 
Folder at the same time: 

 
- Drag your three final project files (yourlastname_composition, 
yourlastname_audio, and yourlastname_analysis) into your Box 
folder: 
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6.  Turn in the hard copies of your composition and analysis to your 
instructor. 

 
 
 

- Congratulations!  You have finished the Final Project. 
 


